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[Abstract] Three-dimensional (3D) cell culture, especially in the form of organ-like microtissues 

(“organoids”), has emerged as a novel tool potentially mimicking human tissue biology more closely 

than standard two-dimensional culture. Typically, tissue sectioning is the standard method for 
immunohistochemical analysis. However, it removes cells from their native niche and can result in the 

loss of 3D context during analyses. Automated workflows require parallel processing and analysis of 
hundreds to thousands of samples, and sectioning is mechanically complex, time-intensive, and thus 

less suited for automated workflows. Here, we present a simple protocol for combined whole-mount 
immunostaining, tissue-clearing, and optical analysis of large-scale (approx. 1 mm) 3D tissues with 

single-cell level resolution. While the protocol can be performed manually, it was specifically designed 
to be compatible with high-throughput applications and automated liquid handling systems. This 

approach is freely scalable and allows parallel automated processing of large sample numbers in 
standard labware. We have successfully applied the protocol to human mid- and forebrain organoids, 

but, in principle, the workflow is suitable for a variety of 3D tissue samples to facilitate the phenotypic 
discovery of cellular behaviors in 3D cell culture-based high-throughput screens. 
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[Background] Over the past years, three-dimensional (3D) cell culture systems, in particular stem cell-

based organoids, have enabled novel insights into human biology and disease (reviewed by: Rossi    
et al., 2018; Schutgens and Clevers, 2020; Kim et al., 2020). However, working with 3D models requires 

more than new cell culture techniques. Quantifying cells in complex 3D tissues in fast, unbiased, and 
efficient workflows requires adapting the analyses as well. So far, many studies have relied on tissue 

sectioning followed by immunostaining to analyze the structures and composition of their 3D aggregates 
in detail (Lancaster et al., 2013; Pasca et al., 2015). While this method has been invaluable, it requires 

ample manual intervention, is time-intensive and cumbersome, and thus not ideally suited for large-
scale screening applications, including drug development campaigns. Moreover, sectioning provides 

only a view at a subset of sample tissue, often results in a loss of spatial information unless meticulous 
serial sections are prepared, and is challenging to use as a basis for 3D reconstruction.  

  More recently, the combination of whole-mount staining and tissue clearing allowed the analysis of 
entire 3D aggregates without the need for sectioning, as demonstrated by our group and others 
(Masselink et al., 2019; Dekkers et al., 2019; Renner et al., 2020). This approach allows rapid 3D 

acquisition of complex samples and preserves tissue context while providing single-cell-specific 

phenotypic information. Our workflow utilizes a customized immunostaining procedure, which we 
adapted and optimized for organoids based on a previous protocol (Lee et al., 2016). We combined this 

with benzyl alcohol benzyl benzoate (BABB)-based clearing (Dent et al., 1989), which clears human 
neural tissues quickly (minutes) and effectively (Renner et al., 2020). We specifically designed this 

procedure to be compatible with both manual pipetting and automated liquid handling systems, 
facilitating low- and high-throughput applications. Depending on the individual requirements, the 

samples can then be analyzed using a standard confocal microscope or a high-content imaging system. 
In either case, the resulting optical tissue cross sections enable the quantitative analysis of entire 3D 

samples down to the single-cell level. This eliminates the need to freeze/section the organoids and 
enables parallel staining and analysis of many samples in 96- or 384-well formats. Though we developed 

the workflow for the analysis of neural organoids, it is not restricted to a particular organoid system or 
sample type but can be applied to any 3D sample of interest. 
 
Materials and Reagents 
 

1. 96-well plates, NuncTM MicroWellTM conical 96-well plates (V-bottom) (Thermo Fisher, catalog 

number: 277143) 
2. Screenstar microplate, 96-well, COC, F-bottom, black (Greiner, catalog number: 655866) 

3. Screw cap tubes (Sarstedt, catalog numbers: 62.547.254 [50 ml] and 62.554.502 [15 ml]) 
4. Serological pipets (Falcon, catalog numbers: 356543 [5 ml], 356551 [10 ml], and 356525 [25 

ml]) 
5. Pipet tips (StarLab, catalog numbers: S1120-1810 [20 μl], S1120-8810 [200 μl], and S1122-1830 

[1,000 μl]) 
6. Conical/V-bottom 96-well plates (Thermo Fisher, catalog number: 277143) 
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7. Optional: Biomek liquid handler pipette tips AP96 P250 (Beckman Coulter, catalog number: 

717252) 
8. Organoids/3D samples to be stained  

9. Dulbecco's Phosphate Buffered Saline (PBS; Sigma-Aldrich, catalog number: D8662) 
10. Paraformaldehyde (PFA; VWR, catalog number: 15714-S) 

11. Triton X-100 (Roth, catalog number: 3051.2) 
12. Sodium azide (Sigma-Aldrich, catalog number: 71289) 

13. Bovine Serum Albumin (BSA, Thermo Fisher, catalog number: 15260037) 
14. Methanol (Roth, catalog number: 4627.6) 

15. Benzyl alcohol (Sigma-Aldrich, catalog number: 305197-100ML) 
16. Benzyl benzoate (Sigma-Aldrich, catalog number: B6630-250ML) 
17. Optional: Nuclear counterstain, e.g., DAPI (Sigma-Aldrich, catalog number: D9542-10MG) 

18. Primary antibodies, depending on application [here: Rabbit anti-Tyrosine Hydroxylase (Abcam, 

product no: ab112) and Goat anti-Sox2 (R&D Systems, catalog number: AF2018)] 
19. Secondary antibodies, depending on application [here: Donkey anti-Rabbit IgG, Alexa Fluor 647 

(Thermo Fisher, catalog number: A-31573) and Donkey anti-Goat IgG, Alexa Fluor 568 (Thermo 
Fisher, catalog number: A-11057)] 

20. Permeabilization buffer (see Recipes, Table 1) 
21. Blocking solution (see Recipes, Table 2) 

22. BABB/methanol (see Recipes, Table 3) 
23. BABB (see Recipes, Table 4) 

 
Equipment 

 
1. Humidified CO2 incubator 

2. Fridges and freezers (4°C, -20°C, and -80°C) 
3. Optional: Stereomicroscope with camera (e.g., Leica MZ10 F (microscope) and Leica DFC425 

C (camera), Leica Microsystems) 
4. Mechanical pipettes 

5. Optional: Multichannel mechanical pipettes  
6. Optional: Automated liquid handling system (e.g., Biomek FXP Laboratory Automation 

Workstation, Beckman Coulter) 
7. Confocal microscope (e.g., LSM 700, Zeiss) 

8. Optional: High-content imaging system (e.g., Operetta high-content imager, Perkin Elmer) 
 

Software 
 

1. Fiji/ImageJ (Schindelin et al., 2012) 

2. Optional: Leica application suite v 4.8 (LAS, Leica Microsystems) 
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3. Optional: Biomek Software v3.3 (controlling the automated liquid handler, Beckman Coulter) 
4. Optional: High-content imaging and analysis software (e.g., Harmony v4.1, Perkin Elmer) 

5. Optional: Excel (Microsoft Corporation) 
 

Procedure 
 
Caution: This protocol uses hazardous substances, including PFA, Triton X-100, methanol, benzyl 

alcohol, and benzyl benzoate. Be aware of toxicity from multiple routes of exposure, including inhalation. 
Refer to MSDS information before starting the procedure and work under a fume hood. 

 
Note: All volumes mentioned here and in the following steps are optimized for samples in 96-well plates; 

other culture formats may require different volumes. For our setup and tissues with ca. 1 mm diameter 

or smaller, we use 150 μl of reagent volume per well. Larger volumes are possible and may be required 

for larger samples; however, we do not recommend going below 150 μl per well for fixation and washing 

to avoid having an insufficient amount of reagent for each tissue. For washing steps, higher volumes 

can increase the washing efficiency, but we found 150 μl per well to give good results. 

 

A. Fixation of large-scale (approx. 1 mm) 3D tissues 
Note: All steps described here can be performed either manually or using an automated liquid 

handling system (ALHS)/pipetting robot.  

1. To fix the samples, carefully aspirate the media and add 150 μl of freshly prepared 4% PFA in 

PBS per well. Incubate for 10-15 min at room temperature.  
2. Aspirate the fixative carefully and wash 3 × 5 min with 150 μl PBS per well. 

3. Either add 150 μl PBS per well and seal the plate with parafilm to store the samples at 4°C or 
directly proceed with the staining procedure below.  

Note: In our hands, several months of storage did not negatively impact the quality of the 

samples for whole-mount staining. However, we generally recommend quick turnaround times 

over longer storage. 

B. Whole-mount immunostaining 
Day 0 
1. Optional: Aspirate PBS carefully, add 150 µl of permeabilization buffer (see Recipes, Table 1) 

and incubate 1 h at 37°C.  
Note: A dedicated permeabilization step is not generally required but may improve the outcome 

for specific markers/sample types. This must be optimized on a case-to-case basis. 

2. Aspirate the permeabilization buffer/PBS and add 150 µl of primary antibody diluted in blocking 

solution (see Recipes, Table 2). Use antibody at the appropriate concentration (each antibody 
must be titrated and validated individually). Incubate 6 days at 37°C and 100% humidity, 

renewing the solution every 2nd day.  
Notes on incubation times and conditions: 1. Incubation times depend on tissue size and density 
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and the antibodies used. We recommend a prior optimization of the incubation times with 

representative test samples; this will save valuable time for follow-up experiments and assure 

optimum outcomes. We found 6 days of incubation per antibody to work well in our samples. 2. 

For the antibody incubation steps, do not seal the plates with parafilm as it may “melt” and 

become difficult to remove from the plate after longer incubation periods at 37°C. Incubators 

should be humidified to prevent evaporative loss of fluids in the plates (almost all tissue culture 

incubators work well for this step). 3. In our hands, samples did not show any signs of 

deterioration over this period. If necessary, 0.1% (w/v) sodium azide in blocking and staining 

solutions can prevent microbial growth during this time (see Recipes). 

 

Note on control samples: Carefully plan control samples to be incubated without primary 

antibody to gauge non-specific binding of secondary antibody. Additionally, prepare control 

samples without antibodies to identify potential artifacts caused by autofluorescence. 

Quantitative assessment needs measurements of both types of background fluorescence to 

determine proper object-based detection thresholds for each channel. 

 
Day 2 

3. Renew primary antibody solution. 
 

Day 4 
4. Renew primary antibody solution. 

 
Day 6 

5. Wash samples with 150 μl 0.1% (v/v) Triton X-100 in PBS for 5 h at room temperature. Renew 
washing solution every hour.  
Note: In case of issues with non-specific/high background signal, washing might be extended 

overnight and performed at 37°C. 

6. Aspirate the washing solution carefully and add 150 µl of new blocking solution with secondary 
antibody 1:1,000 and DAPI (0.5 μg/ml). Incubate for 6 days at 37°C and 100% humidity. Renew 

solution every 2 days. 
Note: This and all following incubation steps should be performed in the dark to preserve the 

fluorescence signals. We have extensively optimized the conditions for various AlexaFluor-

conjugated secondary antibodies and always arrived at a 1:1,000 dilution. We have not 

optimized the conditions for other antibodies (e.g., cyanine dye-coupled antibodies). These may 

require additional optimization, including testing other antibody concentrations. 

 
Day 8 

7. Renew secondary antibody/DAPI solution. 
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Day 10 

8. Renew secondary antibody/DAPI solution 
 

Day 12 
9. Wash samples with 150 μl 0.1% Triton X-100 in PBS for 5 h at room temperature in the dark. 

Renew washing solution every hour.  
Note: In case of issues with non-specific/high background signal, washing might be extended 

overnight and performed at 37°C. 

10. Either replace the washing solution with 150 μl PBS per well and seal the plate with parafilm to 
store the samples in the dark at 4°C or directly proceed with downstream processing (e.g., 

BABB-based tissue clearing below).  
Note: We have not tested long-term storage of the samples before tissue clearing. We suggest 

performing the clearing step within approximately 1 week of finishing the whole-mount staining 

and then storing the cleared samples, which are stable for several months in the dark at 4°C. 

 

C. BABB-based tissue clearing 
1. Carefully aspirate the PBS supernatant from samples and add 150 µl 25% methanol in PBS per 

well and incubate for 15 min at room temperature (RT).  
Note: For larger (> 1 mm) samples, if aggregates are not entirely cleared, incubation times might 

be extended to 30 min (60 min for BABB/methanol). This incubation should be optimized 

individually. 

2. Aspirate the 25% methanol and add 150 µl 50% methanol; incubate for 15 min at RT. 
3. Aspirate the 50% methanol and add 150 µl 75% methanol; incubate for 15 min at RT. 

4. Aspirate the 75% methanol and add 150 µl 90% methanol; incubate for 15 min at RT. 
5. Aspirate the 90% methanol and add 150 µl 100% methanol; incubate for 15 min at RT. 

6. Important: Transfer the samples in 100% methanol from standard tissue culture plates to BABB-
resistant plates (e.g., "Screenstar" COC; BABB/methanol and BABB dissolve most standard 

tissue culture plastic within 30 min). For transfer, cut off the tip of a 1,000 μl pipette tip with 
ethanol-cleaned scissors. Aim to cut the conical tip about 5 mm from the opening at the narrow 

conical end (you can cut off more if your samples are large). This is designed to widen the pipet 
opening to avoid damaging large 3D samples; you can use wide-bore tips for a liquid handler. 

7. Aspirate the 100% methanol and add 150 µl BABB/methanol (1:1, (v/v), see Recipes, Table 3) 
and incubate for 30 min at RT. BABB consists of benzyl alcohol/benzyl benzoate at a 1:1 (v/v) 

mixture (see Recipes, Table 4).  
8. Aspirate BABB/methanol and add 150 µl BABB. 

9. Within 5 min samples are completely cleared and ready for downstream analysis/microscopy or 
can be stored in the dark at 4°C for several months.  
Note: We successfully re-imaged samples that had been stored for approximately 18 months 

without encountering any deterioration in sample quality. 
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D. Fluorescence-based single-cell analysis 

High-throughput applications, including compound screening, must process and treat a large 
number of samples with fast readouts. The combination of our whole-mount immunostaining and 

clearing workflows outlined above with high-content confocal imaging enables the automated 
acquisition of entire 96-well plates in a screening-compatible manner. We have described the 
analysis workflows necessary to analyze this kind of high-content data in detail (Renner et al., 2020). 

However, not all labs have access to the often highly specific hard- and software required for these 

kinds of analyses. Here, we detail a workflow using only standard confocal microscopes and 
freeware. As every 3D sample and staining has specific requirements for image analysis, we do not 

focus on specific parameters but rather on the general procedure, allowing anyone to apply the 
workflow to their own work. 

 
D0. Acquire images, either single optical confocal slices or entire stacks, using a confocal 

microscope. Depending on your analysis needs, you may prefer to image at 8, 16, or 32-bit depth 
with lens magnifications that suit your samples and desired lateral resolution. For our needs, we 

imaged whole organoids with a 10× lens magnification and 16-bit dynamic range (see Figure 1 for 
representative images). Adjust the distance between successive Z-planes to your analysis needs. 

A full 3D reconstruction will require more numerous and more closely spaced Z-planes. For 
quantitative comparison between samples, it is best to space the individual Z-planes further apart 

along the Z-axis, thus undersampling your 3D volume. This avoids data artifacts from double-
counting the same physical feature in adjacent Z-planes and reduces the amount of data acquired 

and the acquisition times. For example, to measure a representative number of nuclei, Z-planes 
should be placed apart further than twice the average diameter of a nucleus. In general, empirically 

choose spatial increments between focal planes so that you can prevent imaging the same sample 
features in adjacent Z-planes, preventing double-counting. 
 
D1. Analysis of nuclear markers (example Sox2, see Figure 1A) 
Note: We describe all analysis procedures using Fiji/ImageJ (Schindelin et al., 2012) as it is freely 

available and commonly used for processing and analyzing biological imaging data (the specific 

commands used for the analysis here and the path to find them are described at each step below). 

However, the same general steps can also be performed with similar software using similar steps 

and parameters. Here, our raw images consisted of 16-bit grayscale data and measured 1024 pixels 

by 1024 pixels. Parameters below are adjusted for these conditions. Other starting points likely 

require the adjustment of downstream image analysis parameters. 

1. Open the 16-bit grayscale image. 

2. Duplicate the image and apply gaussian blur. 
a. Image > Duplicate. 

b. Process > Filters > Gaussian Blur (Parameter used here: 10 px). 
3. Subtract the blurred image from the original. 
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Process > Image Calculator  (then choose operation “subtract”). 

4. Optional: perform smoothing. This can reduce edge artifacts for thresholding operations. 
Process > Smooth. 

5. Apply threshold (the “auto threshold” function can be used, especially for batch analysis of entire 
stacks). 

Image > Adjust > Threshold/Auto Threshold. 
6. Optional: Use watershed to separate objects that have merged but should be separate, such as 

nuclei in close proximity. 
Plugins > Binary > Adjustable Watershed (Parameter used here: 0.5). 

7. Use the “analyze particles” function to measure the number of objects/nuclei.  
Note: Before measuring, use the “set measurements” function to select the parameters you 

want to analyze. Adjust the settings according to your requirements (e.g., increase minimum 

object size to exclude single-pixel noise) and enable “add to manager” (this creates regions of 

interest, “ROIs,” based on the identified objects and adds them to the “ROI manager”) if you 

also want to measure the intensity of the objects later. Larger artifacts like dust or hairs can also 

be excluded here by size. 

a. Analyze > Set Measurements. 

b. Analyze > Analyze Particles. 
c. The results of the analysis appear in the “Results” window and can be exported from there 

for further processing (e.g., to Microsoft Excel or other analysis software of choice). 

8. To measure the intensities, apply the ROIs defined before to the original image (as the raw 

intensity values change during thresholding/processing) via the “ROI manager” and use the 
“measure” function (be sure to select the appropriate parameters under “set measurements” 

before). 
a. Analyze > ROI Manager. 

b. Open original image (16-bit grayscale). 
c. Enable “select all” in ROI manager to show ROIs overlaid on the original image (if too many 

ROIs are selected, deselecting the checkbox marked “Labels” makes the image less 
crowded). 

d. Click “measure” in the ROI manager window to either measure single selected ROIs or all 
ROIs if none is selected. 

 
D2. Analysis of cytoplasmic/filamentous markers (example TH, see Figure 1B) 

For cytoplasmic/filamentous markers, clean segmentation of single cells can be challenging, 
especially in a dense 3D environment where they can span across several z-levels as thin cellular 

projections. Thus, it is often preferable to measure either the integrated or average intensity of 
positively identified structures of interest on every confocal plane. The signal for the whole organoid 

can then be summed for every plane within the organoid and quantitatively reflects the presence of 
each marker of interest contained in the 3D tissue. 
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1. Steps 1-5 can be repeated as described in the Sox2 nuclear analysis above. 

2. Instead of separating the objects by watershedding, continue to define them as ROIs via the 
“analyze particles” function.  

3. Use the “ROI manager” to apply the previously defined ROIs to the original image and measure 
the intensity with the “measure” function (after adjusting “set measurements” to the sample’s 

specific requirements). 
 
D3. Measurement of the sample area for normalization (see Figure 1C for an example) 
Measuring 3D aggregates with varying diameters in different z-levels often requires normalization 

of the data to the total sample area to obtain comparable results between different samples. 
1. Sum all available channels to obtain an image that contains the morphological features of all 

visible elements of the sample across all channels. 
a. Open 16-bit grayscale images of all available channels. 

b. Process > Image Calculator (then choose the operation “add” and select all channels 
opened in step a). This will create a composite image containing all visible features of the 

sample across all fluorescent wavelengths for normalization to the total sample area. 
2. Use thresholding to create a single object from the sample, separating background and sample. 

3. Use the “measure” function to calculate the area of the object (after enabling “area” under “set 
measurements”). 

These procedures can be easily applied to entire aggregates by recording the workflow (with the 
parameters for the specific requirements of the samples) as a macro (e.g., via the “macro recorder”). 

These can iteratively process entire Z-stacks or even groups of Z-stacks contained in a common 
folder. 
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Figure 1. Overview of the different steps of image analysis of whole-mount-stained and 
cleared 3D structures. (A-C) Representative images of the different steps from the image 

analysis process outlined in the Procedure Section D. (D-E) Representative results for the 
analysis of the nuclear marker Sox2. (D) Raw data (i.e., mean gray value for every of the 

identified objects) and (E) frequency distribution based on the data shown in D). Scale bars in 

the top image of each row (A-C) are valid for the entire column of images below. Scale bars: 

entire organoids = 100 μm; enlargement (A, right column) = 20 μm.  
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Data analysis 
 

The manual analysis of images acquired with a confocal microscope is described under “Procedure 

section D: Fluorescence-based single-cell analysis.” The analysis of high-content imaging data is 
described in detail in the original publication (Renner et al., 2020) under “Materials and Methods,” 

“General workflow for high-content imaging and analysis,” and the following sections. 
 
Notes 
 

The BABB-based clearing procedure tends to quench the native fluorescence of fluorescent fusion 
proteins, including GFP, RFP, and all the mFruits. However, fluorescent dyes, including the Alexa 

fluors, are not affected. Thus, we recommend performing the whole-mount staining procedure 
outlined above using specific antibodies raised against the fluorescent protein of interest (e.g., anti-

GFP) to analyze them in BABB-cleared structures. This has the additional benefit of signal 
amplification via multivalent secondary antibodies and better photostability, as commercial dyes 

commonly surpass the bleaching resistance of native fusion proteins. 
  Several steps of the protocol can be optimized to save antibody solution, especially in large-scale 

experiments. Two options that have worked well in our hands are:  
1. Reducing the volume of the antibody solution used to a minimum of 50 μl (for large samples, it 

can also be increased to 200 μl or more to yield better results). 
2. Only replacing the antibody solution once after 3 days of incubation (instead of twice, after 2 

and 4 days). 
Note: This is highly specific for every individual experiment and dependent, amongst other factors, 

on the size of the aggregates and antibodies used. Therefore, this should be carefully validated 

before performing larger experiments or using valuable samples. 
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Recipes 

 
1. Permeabilization buffer (Table 1) 

 
Table 1. Permeabilization buffer 

Reagent Amount for 10 ml Supplier Product no. Dilution factor Stock conc.* 

PBS 9.5 ml Sigma-Aldrich D8662   
Triton X-100 500 μl Roth 3051.21 20 10% (v/v) 

 

2. Blocking solution (Table 2) 
 
Table 2. Blocking solution 

Reagent Amount for 10 ml Supplier Product no. Dilution factor Stock conc.* 

PBS 1.4 ml Sigma-Aldrich D8662   
BSA 8 ml Thermo Fisher 15260037 1.25 7.5% 

Triton X-100 500 μl Roth 3051.21 20 10% (v/v) 
Sodium azide 100 μl Sigma-Aldrich 71289 100 10%(w/v) 

 

*Whereas not required, we recommend preparing intermediary stock solutions of Triton X-100 
(10% (v/v) in PBS) and sodium azide (10% (w/v) in PBS) as facilitates handling.  

 
3. BABB/methanol (Table 3) 

 
Table 3. BABB/methanol 

Reagent Amount for 10 ml Supplier Product no. 

Methanol 5 ml Roth 4627.6 
Benzyl alcohol 2.5 ml Sigma-Aldrich 305197-100ML 

Benzyl benzoate 2.5 ml Sigma-Aldrich B6630-250ML 

 

4. BABB (Table 4) 
 
Table 4. BABB 

Reagent Amount for 10 ml Supplier Product no. 

Benzyl alcohol 5 ml Sigma-Aldrich 305197-100ML 
Benzyl benzoate 5 ml Sigma-Aldrich B6630-250ML 

 
Note: The permeabilization buffer can be stored at room temperature for several months. The 

blocking solution should be stored at 4°C and can be used for approximately 1 month. 

BABB/methanol and BABB should be freshly prepared right before use. 
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